
Introduction
Here are the instructions to perform a Rietveld quantitative analysis on a ZrO2/Al2O3 powder 
sample using Maud.  
Version 2.03 (released September 12, 2005) or higher is needed for this tutorial.  
The spectrum for the analysis has been collected using a standard Bragg-Brentano diffractometer 
and the data file is located in the datasets and examples directory of Maud (the one created by you 
at the first run of the program). The procedure will start creating a basic analysis file setting up the 
datafile and the two phases to analyse. We will build this analysis file in two steps: 
• Step 1: load the datafile
• Step 2: load and modify the phases
Once defined the analysis file, we will start the analysis following two steps: 
• Step 3: set up some "visible" parameters (specifically, the T-PSZ cell parameters)
• Step 4: refine the spectrum by the wizard
The final step (Step 5) will show the analysis output to the user. The tutorial will also guide the user 
to a more accurate and precise analysis if some parameters were not as expected. 
The tutorial has been added by several figures to help the novice in figuring out easily the basic 
procedure to perform this kind of analysis. 
Well, try this tutorial and e-mail us for any problem or question (luca.lutterotti_at_unitn.it). 

Figure 1: Loading the datafile from the main menu



Building the analysis file (step 1: load the datafile)
Start the Maud program or, if you are already in, choose 'New' from the 'File' menu to start a new 
analysis and reset all.
Load the data file alzrc.dat from the "Maud files directory".  
There are three ways to do it. Choose only one.  
a) Locate the file in your system and drag and drop the file over the plot window of the principal 
Maud frame. When you are over with the file you should notice the plot panel border is highlighted.  
b) In the File menu choose Load datafile… (see Figure 1), navigate to the file alzrc.dat and load it.  
c) (This third one is the usual when working with more datasets and datafiles, to get more control 
where to add and how many datafiles for each dataset to have) Select the Dataset_x with the mouse 
and press toolbar button similar to an eye (it says edit the selected object of the visible list when you 
go with the mouse over it). A new window will appear, select the Datafiles tab panel and press the 
Browse.. button to load the datafile. Locate the alzrc.dat file in the databases and example directory 
and load it. Press the OK button to close the dataset edit window at end.
After loading the data file the main Maud window should look like this (Figure 2). You can drag the 
dividers between the four parts of the main panel to adjust their size as you prefer.

Figure 2: Datafile loaded.

You may zoom in the spectrum plot in some details by click, old and drag the mouse over the 
window part you want to zoom in. Double clicking the plot reset the zoom to the normal. By right 
clicking on the plot (CTRL+click, if you have a one-button mouse) you have a small context menu 



for manual zooming or get a coordinate window. Pressing the Plot options button you gain control 
over some plot characteristics.
We do not need to modify the Instrument (inside the dataset) as the one loaded by default is a 
Bragg-Brentano with the correct instrumental aberrations for this data file.
Before to proceed with Step 2 (load and modify the phases) we save this analysis at the present state 
giving it a new name so we can load it again if needed. To complete this choose Save analysis as... 
and choose a location (better not inside the databases and examples directory) and a name for the 
file. It is advised to use a name with extension .par so in certain system (OS X for example) can be 
recognised as a Maud analysis file and double clicking the file, it will be loaded automatically in 
Maud.

Building the analysis file (step 2: load and modify the phases)
Select the Phases tabPanel in the main Maud window.
There should be no phases in the list. If any, select it and press the remove button in the toolbar (the 
one with a red cross).
Press the Load an object from a (CIF) database or file... button to add a new phase (each button on 
the toolbar acts on the selected list and or object/s). Select the database file structures.mdb from the 
databases and examples folder. A window will appear where you can choose the corundum (Al2O3) 
phase first from the visible listbox (Figure 3).

Figure 3: Loading the corundum from the CIF database.



Repeat the procedure to add the phase T-PSZ from the same database. It is a the tetragonal zirconia 
Ce stabilised.
Tip: you may load both phases from the database at once by selecting both. Discontinuous selection 
is permitted. On OS X you can add more selections by holding down the Apple button and selecting 
whatever you need with the mouse click. On Windows and Linux there is the same counterpart with 
their specific button-mouse click procedure.
If you wish to check the phase characteristics for the corundum or T-PSZ you may select the 
specific phase and then click on the edit button on the toolbar (the eye icon button).
A new window will appear with the phase crystallographic and microstructural characteristic and 
models (Figure 4).
You don't need to do anything at the moment. At end close those windows with the OK button.

Figure 4: Editing and checking the corundum phase characteristics.

Building the analysis file (step 3: set up some "visible" 
parameters; specifically, the T-PSZ cell parameters)
We are now ready to check the starting parameters for the quantitative analysis. The main idea is to 
guide a little the starting analysis to ensure the least squares algorithm may find a solution.
In general we should check that the phases we loaded are the correct one for the analysis and in 
particular that the peaks of the phases roughly correspond to peaks in the spectrum.



1. First we compute the spectrum based on the actual parameters. To do this press the calculator 
toolbar button (the tooltip that it is shown when you leave the mouse few seconds over it says 
Compute spectra or from the 'Refinement' menu, click on the Compute spectra menu item. The 
program will compute a spectrum with the actual values of the parameters, phases etc. and the 
spectrum plot panel will be automatically refreshed. You should have at the end something like 
in Figure 5.

Figure 5: Pattern computed for the first time based on initial input.

2. The intensity is quite low and the computed spectrum in the high 2θ part does not correspond 
correctly to the experimental part (see between 140˚ and 150˚). 

3. Zoom in the plot panel in the 70˚-77˚ 2θ region by clicking and dragging a rectangle around the 
plot part you want to zoom in. You should see the two peaks of the tetragonal as in the next 
figure. The first peak (do not consider the small first one) correspond to the 004 reflection of the 
tetragonal PSZ, the second one to the 220. The calculated peaks are instead shifted towards high 
angle. This because the cell parameters depend strongly on the Ce content and the phase in the 
database has a different Ce content respect to the one in the experimental pattern. We will 
change the cell parameters to provide a better starting point (the calculated peaks actually are 
too far from the experimental ones; the least square will diverge).

4. Go to the lower panel containing a list (tree) of objects and parameters. Look for the cell 
parameters of the PSZ and click on the parameter value of cell parameter a. Like in Figure 6.



Figure 6: Enlarging the pattern in the 70-77˚ region and changing the cell parameter. 

Near the value (inside the two arrow buttons) there is a step value. Change the value to 0.01 like in 
the picture. Clicking on the left or right arrow buttons you can decrease or increase the value of the 
parameter by the step value. The change in the value will be followed by a quick computation and 
update of the plot to reflect the change. Try to increase the value of cell parameter a until the 
calculated second peak will be under the experimental one. Do the same for the cell parameter c that 
will only change the position of the first peak. The final result will be like in Figure 7. 
Double click on the plot window to reset the zoom and see the result on the entire spectrum. Now 
you can see there is a better correspondence between computed and experimental peaks. The phases 
are the correct ones. 
The intensity is quite low, so we try to increase it to have a better view. Go again in the lower 
parameter panel and look for the Intensity (scale factor) parameter under the Instrument inside the 
dataset. Select the value, change the step value to 10 and press the right button few times until you 
get an intensity comparable with the experimental one. 



Figure 7: Cell optimised manually using the arrow buttons and checking the plot.

Figure 8: Analysis options panel and store option checkbox.
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Figure 9: Toolbar button to open the wizard panel.

Running the analysis (step 4)
1. We are now ready to start the quantitative analysis.
2. Save the analysis with a name using the 'Save' menu item if you already set up a name to the 

analysis file or using the 'Save as' option from the 'File' menu otherwise. Put a name like 
"AlZr.par" in the "File name" field.

3. TIP: from version 2.04x it is possible to store the spectrum data inside the analysis file, so you 
can save and move your analysis file without the need to carry or move around also the original 
data. To do this, click on the analysis menu bar and select options (this option will move to the 
preferences in the future). A window will appear like in the picture below. Check on the option 
store spectra in the analysis file (circled in red in Figure 8). 

4. In the menu bar click again on the 'Analysis' menu and then on the 'Wizard' menu item. Or use 
the 'Wizard' shortcut in the toolbar (the button with a light bulb; see Figure 9).  
A new window called "Refinement wizard" will appear, showing many option buttons (Figure 
10).  
Right side, in the "Special" panel, choose the option "Quantitative analysis". Then click on the 
'Go!' button and calculations will start up. The information about calculations progress will 
show up in the panel on the left of the plot under the list object panel. Wait until the message 
"End of refinement, have a good day!" at the bottom of the textbox will appear.

Figure 10: Wizard panel and the Quantitative analysis option.

5. Look inside the panel. It is useful to have an idea on how the analysis worked out. The most 
important parameters are the final Rw and sigma values (Figure 11).



Figure 11: R values at the end of the automatic quantitative analysis.

For this analysis, you should have something like: Rw<15.0 and sig<2.0.  
If the values are higher, press again the refinement button (the hammer button on the toolbar) or 
choose 'Refinement' from the 'Analysis' menu bar to let the program do some additional refinement 
iterations with the last parameters refinable.

Analysing the results (step 5)
First save the analysis using the 'Save' option in the 'File' menu.
We are now ready to analyse the results (Each picture in the tutorial is in reality bigger than it 
appears; if you want to see more details, try click with the right mouse button on it and open the 
picture in a new window or tab).  
The first thing to do in a Rietveld refinement is to have a careful look at the plot window. Zoom 
inside the plot panel (by click, hold and drag a rectangle in the plot) to check the details of the 
fitting, see if there are peaks not fitted well, missing etc. Have a look on the residuals, from the 
residual profile you may recognise peak shifts, asymmetry problems and profile shape problems. It 
is much more easy to see them in the residuals than in the plot.  
To have a bigger more customisable plot window click on the 'plot selected dataset' toolbar icon 
(the one with a plot graph icon, circled in red in Figure 12). A new standalone plot window will 
appear with its own menu (on the Mac it appears on top of the screen, in Windows it will be on top 
of the plot window). Resize the window as you prefer (ATTENTION: do not enlarge it full screen 
with the button on the window bar, but resize it instead, because Maud remember the size and 



position of the window and next time it will be hard for you to get a smaller window if you need).  

Figure 12: Separated plot window, useful for customising and copying the plot to another program.

Figure 13: Plot options.



You can change some plot options by selecting the menu item 'Options' from the 'Plotting' menu of 
the Plot window (see Figure 13).
Copying and pasting the plot in you favorite graphic program, or Word whatsoever is easy by 
selecting 'copy' in the 'Edit' menu of the plot window (this works only in the standalone plot 
window). 
The plot options window that appear when you select the menu item 'Options' from the 'Plotting' 
menu permits you to customise the plot. By default Maud plot the intensities in sqrt (see the red 
annotation circle on the picture below) but you can change it to linear or log scale. Some of the 
scaling in log are useful for reflectivity plots. 
TIP: plotting the intensity in sqrt permits a better evaluation of the residual as they will be plotted at 
iso-statistical-error because the intensities in diffraction have errors proportional to the 
sqrt(intensity). Also you may better see small peaks compare to the big ones. You can change also 
the data markers. The kind of marker can be selected by changing the number of the marker (the 
default is 4) There are already 10 markers defined in Maud (from 1 to 10), in addition if you put -1 
in the data marker then you will get a line for the data plot. If you want to change the marker 
appearance and get your ones have a look at the 'marker.txt' file in your examples/databases/
preferences directory. Simply add a new marker at the end and define it. It is straightforward to 
understand how the script works.
Close the plot window at end. Remember to not leave opened Maud windows around has if you 
open one twice there is no control and you can mess up the parameters a little. 

Figure 14: results window.



Now, select the 'Results' option from the 'Analysis' menu. A new window like in Figure 14 will 
appear. You will find all the information listed in the text box during the calculations. The most 
significant parameter concerning our quantitative analysis are visible in the portion shown in the 
window. Scroll up or down to find it. At the beginning there is the list of peaks and then the 
parameters correlation matrix, just after it there are the refined parameters. If you look you will find 
the refined volumetric quantity of Al2O3 as a fraction of 1 (the T-PSZ quantity is complementary to 
1). Close the window when finished. 
If you wish to get both volume fraction and weight fraction of the phases, it is better to browse the 
sample object.

Figure 15: sample panel showing the volume and weight fractions.

In the main Maud window, select the 'sample' tab panel in the upper-left part of the window. Select 
the only sample present there and press the 'edit' toolbar button ('eye' toolbar button). A new 
window will appear like in Figure 15. Looking at the picture where the red circle is, you can select 
the phase you want and see the volume and phase fractions. Errors are reported only for the refined 
phase fraction in the result (Figure 14) or parameter list (Figure 16) windows. 
You may check the entire parameter list to see which parameters the program has been set refinable 
automatically. TIP: actually the parameter list panel below the plot does not have a button/options to 
expand the entire tree of objects/parameters. But if you choose 'Parameters list' from the 'Analysis' 
menu bar, the a new window will appear (Figure 16). Enlarge the window by dragging down its 
lower/right corner until you will see all the buttons in the lower panel of the window and press the 
'Expand all' button near the 'Close' button in the lower-right corner.



Figure 16: parameter list window, you need to press the “Expand all” button to see all parameters in 
the tree or expand one by one.


